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1 Introduction

1.1 Welcome

Welcome to Complete Time Tracking Standard

Complete Time Tracking Standard is an advanced time tracking application that enables you to
track your time using automatic time recording and manual time entry and allocate your time to
particular categories that you define, such as customers, projects and tasks. You can generate
various summary and detailed reports on your recorded time.

Complete Time Tracking Standard uses a separate time recording database for each user and is
therefore suited to individuals or small teams where there is no requirement to generate reports
including time from multiple users. If you would like a time tracking system with full multi-user
support including a central database, user login and security, and multi-user reports then look at 
Complete Time Tracking Professional.

Complete Time Tracking Standard can be run as a fully-functional 30-day trial for evaluation
purposes and also comes with a 30-day unconditional money-back guarantee from the date of
purchase. See the Purchasing section below for more information.

Getting Started
See the Getting Started section for information on configuring and using Complete Time Tracking
Standard.

System Requirements
See the System Requirements section for details on the minimum computer requirements to use
Complete Time Tracking Standard.

Purchasing

You may evaluate Complete Time Tracking Standard for 30 days. After that period you must
purchase Complete Time Tracking Standard or discontinue using it.

To purchase Complete Time Tracking Standard select Purchase Online from the Purchase
menu. If your 30 day evaluation period has expired you will be presented with an evaluation
expired notice when starting Complete Time Tracking Standard. You can purchase by selecting
the Buy Now button.

A licence for Complete Time Tracking Standard must be purchased for each user. Substantial
discounts are provided for multi-user purchases. You can purchase additional user licenses at any
time.

For more information see the Purchasing and Registration section.

See also:
Purchasing
Complete Time Tracking Overview
Getting Started

http://www.complete-time-tracking.com/
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2 About Complete Time Tracking

2.1 Overview

What Is Complete Time Tracking Standard

Complete Time Tracking Standard is an advanced time tracking application that enables users to
record time and allocate it to particular user-defined categories, such as customers, projects and
tasks. Users can automatically record their time, enter their time manually, or use a combination of
both.

Time tracking is known by several names including time recording, time clock, time card, time
attendance, timesheet/time sheet and timekeeping/time keeping. Regardless of the terminology
Complete Time Tracking Standard is the perfect solution.

Benefits

· Produce weekly timesheets with ease.

· See exactly where you are spending your time.

· Accelerate employee productivity.

· Bill customers with confidence. Set hourly rates for defined categories. Provide your customer
with a detailed or summary report of the time spent on projects and tasks.

· Record time easily and automatically. 

· Improve your project management.

· Increase your time estimation accuracy.

· User-defined flexible categories.

· Easy access to completed works history.

Complete Time Tracking Standard is extremely easy to use and its powerful time tracking abilities
allow you to see exactly where you are spending your time and facilitate customer billing by
calculating time costs based on hourly rates.

Features

· Easily record time automatically, enter time manually, or use a combination of the two. 

· See at a glance: the current customer, project and task (or any category that you are working
on), the start time, duration, hourly rate and amount earned, and total time recorded on the
current day. 

· Track time by user-defined flexible categories and any level of sub categories.

· Add notes to the work time recorded to keep a history of what the time was spent on.

· Record progress and completion of categories. When a category is completed it can be
optionally automatically hidden from selection.

· Immediate access to the time tracking window without obscuring other applications using
unique auto-hide at screen edge functionality.

· Advanced reporting on summaries and detail across flexible time periods and broken down
by category and date. Many report formats are included..

· Reports can be displayed and printed, or exported in HTML, Text, CSV, Microsoft Word*,
Microsoft Excel*, or XML format for publishing to the Web or integration with other software.

· Detailed online help and user manual.

· And much more! 

* Requires Microsoft Word or Microsoft Excel to be installed on your computer respectively.

Feedback

We welcome any feedback that you may have about Complete Time Tracking Standard. Many of
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the features and functionality have been designed based on customer feedback.

HOW-TO
Providing Feedback
1. Select Feedback from the Help menu in Complete Time Tracking.
2. Fill out our quick online feedback form.

2.2 What's New

17-Jan-2008 v2.54
Enhancements
· Improved the performance of "by category" reports by approximately 5 times.

· Now uses native report export to Excel format which does not require Excel to be installed on
the computer, is much faster and also includes cell formatting.

· Added the ability to execute database management statements to the debug database script
window.

· Added "copy to clipboard" and "open folder" options to the database location in the debug
window.

Fixes
· Wrap long database location displayed in debug window.

· Don't prompt to close when Windows is shutting down.

· Current/Today duration mode switching on main tracking window is working again.

· Show all lines of multi-line notes in the report Data View and include them in all export formats.

22-Mar-2007 v2.53
Enhancements
· Greatly improved performance when loading the category list. The category list is loaded when

the program is started, when entering and exiting the category configuration window, when
entering the edit recorded time window and changing selections, and when entering the reports
window. Running reports is still slow on systems with a large number of categories as it uses a
different technique and will be addressed in a later release.

19-Mar-2007 v2.52
Enhancements
· New debugging feature to display the database location.

· New debugging feature to allow an error report to be generated on demand to retrieve system
information.

· New debugging feature to allow SQL statements to be entered to query and update the
database.

· All executables are now code-signed.

· Added re-branding support for Resellers.

· Several minor changes.
Fixes
· Display '&' character in category name and registration name correctly.

· Removed an error generated when leaving empty values during inline editing of recorded time
entries.

11-Jul-2006 v2.51
Enhancements
· The title displayed on preview and printed reports is now configurable.

· The report type can now be optionally displayed on preview and printed reports.

· The amount earned is now displayed and updated when in manual time tracking mode and a
valid start time is entered and the end time is set to 'now'.

· Allow more flexibility in specifying times and dates. Added the characters - , and ; as valid hour,
minute and second time separators (in addition to the existing characters . : and the current
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Windows region time separator setting). Added the characters . , - / and \ as valid day, month
and year date separators (in addition to the current Windows region date separator setting).

· Added an option to allow auto-resuming of automatic time recording on the current category
when the computer becomes active after an inactivity timeout.

· A user name can now be optionally displayed on preview and printed reports.

· Gaps from the end of the last recorded time entry to the start of the currently recording time
entry are now highlighted in the Edit Recorded Time window.

Fixes
· Display the example duration formats in the program options using the regional settings for the

decimal and time separators.
· Allow times to be entered when the regional settings for the AM/PM symbols contain '.'

characters such as New Zealand where the symbols are "a.m." and "p.m."
· Expanded time display fields in windows and reports to accommodate longer time formats used

in some regions.
· A disabled timer whilst the main window was hidden off-screen meant that the duration

displayed in the system tray icon hint was not being updated and automatic time recording was
not stopping when the configurable idle time was exceeded.

· Adjustments of the size and position of columns in reports to accommodate large earnings
amounts.

· Adjusted size of report pages to print better on both A4 and US Letter paper.

· The calendar controls used on the reports window were changing the date range quick selection
to Custom if the window was left open for several minutes.

· The total duration for the current day and the adjust start time option to use the previous time
entry end time were not being updated when time was manually added.

· The Notes field displayed in the Full Details report was being truncated.

· Improved display of long fields such as category names and user names in the preview and
printed reports.

26-Jun-2006 v2.5
New Features
· Stop automatic time recording when the system has been idle for a period of time. On Windows

2000, XP, 2003 and Vista computers this can be configured as a number of minutes. On
Windows 98 and ME computers the time recording stops when the screen saver is activated.

· Gaps between time entries and overlapping time entries can be optionally highlighted in the Edit
Recorded Time window when the ALL category is selected. Small gaps and overlaps can be
ignored by specifying the duration to ignore. Gaps can be allocated to a new time entry or an
existing adjacent time entry. Time entries can be trimmed to remove the overlap.

· Optional skinned user interface (enabled by default) with 13 selectable skins. This feature is not
currently enabled on Windows Vista.

Enhancements
· Several changes to support Windows Vista.

· The date to display recorded time for can now be entered directly in the Edit Recorded Time
window.

· Warn if the ALL category is selected when saving changes in the Edit Time Entry window.

· Changed time entry in the "Adjust start time" and "Edit Recorded Time Entry" windows to
free-format text to make them easier to use.

· The text "now" can be entered where a time is required, such as in manual time entry on the
main window or in the Edit Time Entry window.

· When adding a new time entry using the Edit Recorded Time window and currently recording
time then default the end time of the new entry to the start time of the currently recording time
(ie. Fill the gap).

· When adding a new time entry using the Edit Recorded Time window and not currently recording
time then the end time is set to "now". It was previously set to the explicit current time that the
Add button was clicked which could be some seconds or minutes before the time entry is added.

· The first time entry start time and last time entry end time are displayed in bold text to make
them easier to identify visually.

· The time details category percent complete is now always retrieved when a category is selected
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on the main window. The program option to retrieve time details now only applies to the time
details notes.

· Added a new option to automatically clear the time details notes when time is recorded on the
main window (select Stop or select a different category when automatically recording time, or
select Add Time in manual time tracking mode).

· Added two new options in the "Adjust start time" window (when you click the "Started" link on the
main window when time is recording): 1) use the current time, 2) use the end of the previous
time entry on the current date.

· The total amount earned for the current day is now displayed on the main window when "Today"
is selected in the automatic time recording details.

· The start time in the manual time entry mode is now automatically set to the end time of an
automatic recorded time entry, making it easy to fill in additional time manually later.

· The end time in the manual time entry mode is now automatically set to "now" as the most
common usage of manual time entry is to record the time just worked. This can be disabled in
the program options.

· When a valid time is entered as the manual start time and "now" is entered as the manual end
time on the main window the duration is displayed and updated above the manual duration entry.
The manual duration entry is set to empty.

· The text in the start time, end time and duration in the manual time entry section on the main
window are now automatically selected when the field is first clicked in to allow easier
replacement by simply clicking and typing.

· When starting the program the start time in the manual time entry on the main window is now
automatically set to the end time of the last time recorded on the current day.

· Added Start/Stop Recording/Add Time menu item.

· Swapped position of category selection and user selection in reports window as the category
tree needs to be much wider than the user list.

· The selected category and date range can now be optionally displayed on preview and printed
reports.

· Changed the wording in some information messages to make them easier to understand.

· User interface is now Windows XP theme compliant.

· New icon theme used for buttons and menu items.

· The system tray icon is now animated when recording time.

· The system tray icon popup hint now displays the name of the selected category, start time and
duration.

· Added icons to popup system tray icon menu.

· Added "Center on Screen" and "About" menu items to the popup system tray icon menu.

· Improvements to trap Windows shutdown notification and stop automatic time recording.

· The Windows system locale First Day Of Week setting is now used instead of Monday to set the
default "first day of the week" option.

· The license name is now displayed on the toolbar and full license information is displayed in the
Help, About window.

· The error reporting system now uses a wizard style to provide the user with more control over
the information sent and make it easier to comment on the problem.

· New uninstall feedback application to replace the online feedback form. This is less intrusive
than opening a browser window.

· The start/stop recording button on the main window is now disabled when the window is hidden
off-screen to avoid unwanted start/stop if the Enter/Return key is pressed whilst the window is
the active Windows program and hidden.

· Improved ability for main window to appear on top of all other windows when it appears from the
edge of the screen.

· Group category selection is now enabled by default.

· Only show tooltip hints in the Edit Recorded Time time entries grid for the category and notes
columns.

· Changed the font used throughout the program to Tahoma to resolve a problem with the Arial
font previously used where if the first letter of text is 'W' then it is sometimes not displayed or
only partially displayed.
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· Improved format and information on trial reminder and trial expired windows.

· Added an application icon to the database delete utility.

· Only enable the Delete button in the database delete utility if a database is selected.

· Several minor improvements to the user interface.

· Expanded detail in some sections of the help file and user manual.
Fixes
· Fixed a category ordering problem which under some circumstances would cause problems in

the weekly timesheet report and some categories in any "by category" report to be repeated.
· Replaced calendar controls to avoid a complex bug in the display of the original controls used.

· A program error was generated if whilst editing in the Edit Recorded Time window recorded time
grid the category tree was clicked.

· Do not allow multiple reports to be previewed at the same time. This was causing problems as
the report system was not designed for parallel report preview.

· Expanded amount earned column in reports to cater for wide currency formatting.

· Ensure that there is absolutely no unrecorded time when recording and switching tasks on slow
computers or when the system is very busy.

· Do not allow a group category to be selected in the edit time entry window of edit recorded time
if either the user does not have security access to record to group categories (Pro) or the users
program options are set to not allow recording to group categories, except if editing a previously
recorded time entry recorded to a group category and the category is not changed.

· In some cases the total duration displayed in the Report View window was truncated to be less
than 24 hours.

· If a sub-category was moved to a new category group and the old group category was deleted
then the moved category was also being deleted.

· Remove input focus from the Notes and % Complete items in the time details on the main
window when hiding the time details section to allow the window to auto-hide.

· In the reports window if an end date was manually typed in then in some cases the start date
was being set incorrectly. This was caused by a partially entered date such as 01/01/0 (typing
01/01/06) to be interpreted as 01/01/2000.

· Fix for very long category names which were causing an error in the weekly timesheet report.

· Check that a printer is installed and a default printer is set in the Windows control panel before
allowing the report preview/print.

· Do not display the amount earned when in manual time tracking mode when the start time or
end time is invalid.

· Ensure that the window is displayed longer when the system tray icon is clicked or the Show
menu item in the system tray icon popup menu is selected when the main window is hidden.

· In some rare circumstances categories could be set to 100% complete and not visible for
selection when not intended.

· If automatic time recording was stopped without a direct user selection (e.g. program closed
without stopping time recording, windows shutdown and so on) then the time details notes and
percent complete were not being recorded.

· Resolved potential window scaling problems for some windows on computers with non-standard
DPI settings.

· Always ensure that windows are initially displayed on screen in the case where display resolution
or other settings cause previously visible windows to be placed off-screen.

· Resolved a rounding issue that would display the initial duration today on the main window as
00:00:01 instead of 00:00:00 if no time has been recorded.

· Program version number was not being displayed correctly in the Windows Add or Remove
Programs dialog.

· Fixed the popup hint message for the user delete button.

· Set the Start In folder in desktop and quick launch bar shortcuts which fixes help, manual and
video tutorials not displaying when run directly from the shortcuts.

· Resolved several minor issues when run on Windows NT.

26-Aug-2005 v2.42
Enhancements
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· Added a display option to set whether the main tracking window slides or jumps when showing
and hiding at the edge of the screen.

Fixes
· Additional fix to version number interpretation to work in locales where a period '.' is not the

character used to separate the decimal amount in numbers, such as in Germany and Lithuania.

22-Aug-2005 v2.41
Fixes
· Correctly retrieve and display the total duration for the current day when the "Today" option is

selected in the main tracking window.
· When selecting the Keep button in the delete utility when uninstalling don't force the selection of

a database and don't delete the database.
· Don't display both the personal (CTT Std) and shared (CTT Pro) databases for selection in the

database delete utility on uninstall. Only display the database relevant to the CTT edition being
uninstalled.

· Allow the main Reports window to be minimized.

· Fix to version number interpretation to work in locales where a period '.' is not the character used
to separate the decimal amount in numbers, such as in Germany and Lithuania.

· Allow recorded time in the Edit Recorded Time window which has been modified and changed to
a different start date to be deleted.

· When currently automatically recording time for a category and in category configuration the
category visibility for selection is modified to be unchecked or the percent complete modified to
be 100% and the "auto hide for selection when category is marked as 100% complete" option is
selected then don't override the category percent complete with the value entered in the time
details in the main tracking window when the time recording is automatically stopped because
the category is no longer visible for selection.

08-Aug-2005 v2.4
Enhancements
· Category codes are now displayed in reports if the "use category codes" program option is

enabled.
· The selected category is now displayed in bold on the main time tracking window.

· Renamed the New buttons to Add and the Edit buttons to Modify, uniformly in all windows.

· Modified some reports to ensure that the same formatting is used in all reports.

· Add, Add Subcategory and Modify in the category configuration window are now performed in a
pop-up window so that making changes is more explicit.

· Double-clicking a category in the category configuration window will display the modify window.

· Added a Modify item to the category configuration popup menu.

· Added a popup menu in the Edit Recorded Time window with options to Add, Modify and Delete.

· Pressing the delete key when a time entry row is selected in the Edit Recorded Time window will
delete the time entry.

· Changed hidden category color in category tree to match new inactive user color in user list.

· Allow several shortcut time formats in manual time entry. For example, 9/900/9.00/9:00/9am are
all interpreted as 09:00.

· Smart interpretation of 12-hour short format end times to be post-midday times. For example, if
the start time is 11:00 then an end time of 2 is interpreted as 2PM (14:00).

· When manual time is entered the next start time is set to the previously entered end time, the
next end time is cleared, and input focus is moved to the end time to make successive time
entries easy.

· Added "Last 3 Months", "Last 6 Months", "Last 12 Months", "This Year" and "Last Year" quick
date range selections to the Reports window.

· When the start date is changed in the Edit Time Entry window of Edit Recorded Time then end
date is changed to match.

· Always display the category for recorded time in the Edit Recorded time window to avoid the
confusion over it disappearing when there are no sub-categories for the selected category.

· Reduced delay before automatic hide of the main window.
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· Added a delay before automatic show of the main window to avoid accidental showing.

· Added a default button on all windows, normally the OK or Close button, activated by pressing
Enter.

· Improved the explanation in the database deletion utility which is automatically run on uninstall
and improved its database detection.

· Updated user interface controls to Windows XP look.

· Changed the button layout in all windows to be consistent.

· Added 32-bit alpha blended and 4-bit transparent application icons.

· Only save the "start when Windows starts" option when it changes to avoid unnecessary
notifications from applications which monitor startup registry entries.

· Improved category sorting in reports.

· The database restore now makes a backup copy of the current database file.

· The online help is now in HTML Help format.

· Revised the online help and user manual, updating text where appropriate, standardizing the
layout and formatting in all topics, updated all screen shots.

· Added enhanced error reporting to pinpoint program errors. Detailed information about what the
program was doing at the time of the error is logged and a screen-shot is automatically taken.
The error report can be easily emailed.

· Enhanced database upgrade functionality with auto resume after error support and upgrade
progress notification.

· The Backup and Restore menu items are now located under the Tools menu.

· Added interpretation of several database errors to present a more user-friendly error message.

· The database version is now displayed in the Help, About window.
Fixes
· Fixed running of the user manual and short video tutorials when selected from the help menu.

· Remember the "show hidden categories" selection in the reports window.

· Fixed error when adding recorded time in the edit recorded time window with the percent
complete set to 100.

· Removed erroneous category headers in the weekly timesheet preview/printed report which
were appearing in certain conditions.

· Don't keep the end of the current database file when restoring a backup of a smaller database
file.

· Automatically uncheck the category visibility for selection if the category is set to 100% complete
from within the category configuration window.

· Don't uncheck the top-level ALL category visibility for selection if recorded time is added for the
ALL category and set at 100% complete.

· Ignore modified and deleted time entries when calculating which default start time to use for a
newly added time entry.

· When a network share is detected for the Windows user roaming profile the users non-roaming
profile is used to store the backup instead of producing an error when connecting to the
database.

Other
· "Parent" categories are now referred to as "group" categories.

04-Apr-2005 v2.32
Fixes
· Removed unnecessary show and hide of the main time tracking window when selected as the

active Windows application.
· Fixed the Tools, Options menu item.

· Enable the category level selection for the full details report.

· Fixed the total recorded time duration for the current day on the main time tracking window.

07-Mar-2005 v2.31
Fixes
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· Auto-hide again after Windows display settings are changed, such as the Windows taskbar
auto-hide, screen resolution, or the desktop orientation is changed in a tablet PC.

02-Mar-2005 v2.3
Enhancements
· Added shortcut keys for selecting a category and changing the started time in the main tracking

window.
· Renamed report "Print" button to "Report" and "View" button to "Data", changed their order and

changed the printer icon to a report icon so that the main reporting option to use is clear.
· Changed the layout of the reports window to put the start and end date side by side which is

easier to read.
· Added support for systems with multiple monitors.

· Added keyboard shortcuts to activate category selection and to adjust the start time on the main
time tracking window.

· Moved the Help buttons to the left of the dialogs to give clear separation from OK/Cancel/Close
buttons.

· Use a more modern image in the installer.

· Added a Repair option to the uninstaller.
Fixes
· Display and use the new hourly rate for recorded time if it is modified from the categories hourly

rate in the Edit Recorded Time dialog.

07-Feb-2005 v2.2
Enhancements
· Added several short video tutorials to demonstrate how to perform common tasks. The video

tutorials are accessible from the Help menu, start menu, and links within the online help and
user manual.

· Install the PDF user manual with the program. The user manual is accessible from the Help
menu, start menu, and links within the online help.

· Added more prominent support options.

· Generate a default email containing the program and Windows versions when contacting
support via email.

· Don't prompt to confirm category deletion if the category is new and has no sub-categories.

· Prompt to confirm cancel in the category configuration and edit recorded time dialogs if changes
were made.

· Changed the report type selection to a tree view grouped by report type.

· Added a Help button to most dialogs to display the appropriate online help for the dialog.

· Better selection of time entries when adding, deleting or editing time in the Edit Recorded Time
dialog.

· Added keyboard shortcuts to the controls on the report options dialog.

· Added popup hints to many controls.

· Added icons to most menu items.
Fixes
· Program options are now saved when modified rather than when the program closes to avoid

problems when closing due to Windows shutdown.
· Ignore deleted categories when checking for duplicate category names.

· Removed temporary display of the amount earned when exiting the options dialog.

27-Jan-2005 v2.12
Fixes
· After a backup is restored check the database version and perform an automatic database

upgrade if required.
· Set input focus to the start/stop button on show of the main tracking window to allow auto hide. If

focus was on the time details notes or percent complete at the time of auto-hide then the window
would not auto-hide after the next show unless input focus was changed.
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23-Jan-2005 v2.11
Fixes
· Fixed database restore so that database file is restored to the correct location.

20-Jan-2005 v2.1
Enhancements
· Printed reports can now display up to 5 category levels.

· Categories can now be moved in the edit category dialog by dragging and dropping.

· Added a right-click popup menu to the category tree in the edit category dialog with the options
New Category, New Subcategory and Delete.

· Categories can now be deleted in the edit category dialog by pressing the Delete key.

· Added support for automated database upgrades, a required feature for this release to apply
changes made to the time tracking database structure for the new multi-level category reports.

· Group categories can now optionally be selected for time recording. This option can be enabled
in the options dialog.

· Reduce the number of steps in the quick start tutorial from 10 to 5.

· Added the ability to not show the hourly rate and amount earned in dialogs and reports.

· Save report dialog selections for report type, date range and custom dates.

· Move the main window to the centre of the screen when the quick start tutorial is started.

· Time entries manually added in the edit time dialog are now displayed with other time entries in
time order.

· Program errors are now logged. On closing the program the error log is displayed if any errors
occurred and the user is prompted to email the error log to technical support.

· Don't force the user to wait 5 seconds before the evaluation notice can be dismissed in trial
mode.

· Added icons to menu items.

· Improved compatibility on Windows 95 and Windows 98.

· Increased the category selection speed on the main window.

· The start when Windows starts option now allows the location of the application to be changed
from where it was first run.

· The installer now checks that the Winsock 2 upgrade is installed on Windows 95 computers and
prompts the user to download it from the Microsoft web site.

· The "New Category" text is now selected when a new category is added by pressing the
accelerator keys to allow a new name to be more easily specified.

· Adjusted main window title bar color to work better with a variety of windows appearance
settings.

Fixes
· Fixed a problem where changes to the category configuration would cause currently recording

time to not be saved under some circumstances.
· Fixed a problem in the edit time dialog when a date is selected or a category is selected which

sometimes caused unexpected behaviour or a program error.
· Improved handling of system suspend/stand-by.

· Edit category dialog now warns about categories with duplicate names instead of ignoring their
changes.

· Improved hiding at the Windows taskbar so that the time tracking window always hides behind
the taskbar and does not show when the mouse moves over the taskbar in front of the window.

· Resolved a problem where the main window was sometimes disabled when hiding at the
Windows taskbar and the taskbar position changed and also when resuming from a suspend or
hibernate.

· Resolved duplicate accelerator (alt) key assignments in the edit categories dialog.

· When the hourly rate was modified for the currently selected category it was displayed but not
used in recorded time.

· Correctly save all changes in the configure categories window when multiple categories are
added or modified.

· Date range on reports dialog was showing as custom when it should be This Week.
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· Correctly align columns in the "view" report grid.

· Time entries manually added in the edit time dialog are now only displayed for the date they
were added on and only if they are for the selected category or a subcategory of the selected
category.

· The value of grand totals in reports were being doubled when printed.

· Retrieve the percent complete for a selected category from the category, not the last recorded
time for it. This allows for an initial percent complete to be set for the category before any time is
recorded.

· Don't allow the quick auto start time adjustment to be after the current time.

· Shortcut/accelerator keys now select the correct control (various dialogs).

30-Dec-2004 v2.01
Fixes
· Fixed window scaling problem when run with different Windows display settings such as large

fonts or DPI.

14-Oct-2004 v2.0
New Features
· New database engine for increased performance and design flexibility and as preliminary

development for a multi-user version of Complete Time Tracking.
· The previous fixed customers, projects and tasks have been replaced with a flexible hierarchical

category system which can be configured to support a wider variety of uses.
· Modify and delete previously recorded time and manually add time for any date.

· New weekly timesheet report.

· New notes field for categories to record information such as customer contact details or project
details.

· Several reports now include grouped sections with subtotals in the report print and totals in
report view and export.

· Database backup and restore.

· Optional override of recorded time durations to allow manual rounding adjustments.

· Option to start when Windows starts (enabled by default)
Enhancements
· Added continuous automatic time recording. Time recording does not stop when a different

category is selected.
· Improved the category "visibility" concept to provide more flexibility and allow quick show/hide of

hidden categories.
· Added the option to automatically hide categories from selection when marked as 100%

complete.
· Added yesterday and last 30 days to date range selections.

· Added a main menu to the toolbar.

· New option to retrieve the last recorded notes and percent complete when a category is selected
on the main recording window.

· The start time can be adjusted when currently auto recording time.

· The first day of the week and work start time of the day can be configured. These options are
used with the new weekly timesheet report and when adding the first recorded time for the day.

· Show the main time tracking window when the system tray icon is clicked.

· Added a popup menu when the system tray icon is right clicked with options to show or exit.

· Added a feedback option in the help section of the new menu.

· Prompt for feedback when closing the application if it is a beta release.

· Changed color and icons in toolbar buttons to help distinguish their purpose.

· Attempt to connect to the database up to 3 times and display an error and abort if failed.

· Display registered user in title bar.

· Don't reset duration to zero when automatically recorded time is stopped.

· Display the duration in bold during automatic time recording.

· Increased the size of the recorded time notes from 250 to 1000 characters.
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· Faster auto-hide and show of main recording window when docked to the screen edge.

· Show/hide time details when details bar clicked. Previously the min/max icon needed to be
clicked.

· Report line spacing reduced to increase the number of items displayed on one page.

· Don't auto-hide if the time details or manual time recording fields are selected.

· Provide visual feedback that manual time was added.

· Significant changes to help file.
Fixes
· Recognise Windows shutdown and stop automatic time recording.

· Clear notes and percent complete when a different category is selected and the "retrieve last
recorded time details" option is not selected.

· Fix path to data storage folder.

· Close application when registration key is entered from options dialog.

· Modified product wording when entering registration key.

· Fixed tab order on report view window.

· Fixed problems with system tray icon on Windows startup.

· If printed report contains no data the duration on the empty details line was still printed.

06-Jun-2004 v1.1
· Additional report types added.

· Minor fixes.

· Significant changes to help file.

07-May-2004 v1.0
Initial Release
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3 Installation

3.1 System Requirements

The following are the minimum system requirements to use Complete Time Tracking Standard.

Computer

· Intel Pentium III 500 or AMD Duron 500 CPU.

· Windows 98, ME, NT4 SP6, 2000, XP, 2003 or Vista.

· 128 MB RAM (256 MB recommended).

· 20 MB disk space for the installed program.

· In addition to the above requirements we recommend that you use a screen resolution of
800x600 or higher.

An installed printer is required to preview and print reports. A virtual printer such as the free 
PDFCreator (which is great for generating PDF files of any document in any application) is
sufficient.

Microsoft Word and Excel must be installed on the computer to export reports in Microsoft Word
and Excel format.

See also:
Installing Complete Time Tracking Standard

3.2 Installation

You can download the installation program from the download page of the Complete Time
Tracking web site.

To install Complete Time Tracking Standard simply double-click on the installation program and
follow the steps in the installation wizard.

See also:
System Requirements

http://www.pdfforge.org/products/pdfcreator
http://www.complete-time-tracking.com/download/
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4 Getting Started

4.1 First Steps

Getting Started

There are several broad ways to use Complete Time Tracking, described below.

Record time as you work
Use the automatic time recording system (similar to a stopwatch) to track your time. Select the
appropriate category and start the time recorder at the beginning of the day as you begin work.
When you begin work for a different customer, project or task simply change the selected
category. Time recording will stop on the previous category and start on the new category. At the
end of the day stop the time recorder or simply log off or shut down Windows.

Record time when each item of work is complete
Use the manual time entry system to track your time. Set the program option to automatically set
the end time to 'now' when a time entry is added. As you complete work for a customer, project or
task select the appropriate category and select Add Time. A new time entry will be recorded for the
category from the end of the previous time entry to the current time. The next time entry start time
is taken from the end time of the previously entered time entry to allow continuous recording of
time without gaps, making time entry easy. Repeat this simple procedure throughout the day.

Record time at the end of the day
Use the manual time entry system to track your time. Disable the program option to automatically
set the end time to 'now' when a time entry is added. At the end of the day enter a time entry for
each customer, project or task that you worked on by selecting the appropriate category and
entering the start and/or end time. The next time entry start time is taken from the end time of the
previously entered time entry to allow continuous recording of time without gaps, making time entry
easy.

Setting Up
With Complete Time Tracking Standard you record time to user-defined categories and sub
categories. Using Complete Time Tracking Standard typically involves the following steps:

· Configure categories

· Record time

· Edit time (if necessary)

· Produce reports

You may also want to review the Program configuration options which allow you to change the time
duration format, set the default start time and enable various optional features.

Learning How To Use Complete Time Tracking

Interactive Quick Start Tutorial
Complete Time Tracking Standard includes an interactive tutorial to show you how to use the
essential features. The tutorial should take no longer than two minutes to complete and is highly
recommended.

HOW-TO
Run the Interactive Quick Start Tutorial
The tutorial starts automatically the first time that Complete Time Tracking Standard is run. It can
be restarted at any time by selecting Interactive Quick Start Tutorial from the Help menu.

Short Video Tutorials
Complete Time Tracking Standard includes several short video tutorials to demonstrate the most
common tasks. The video tutorials are displayed in your web browser.
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HOW-TO
Display Video Tutorials
1. Select Short Video Tutorials from the Help menu in Complete Time Tracking.
2. Select a video tutorial to watch.

Note: If your default web browser is Internet Explorer and it displays a security warning stating
"Internet Explorer has restricted this file from showing active content" then you will need to click the
warning and select Allow Blocked Content. This warning appears because the video tutorials
require the Macromedia Flash player to run to display the content.

See also:
Auto Hiding the Tracking Window
Configuring Categories
Tracking Your Time
Editing Recorded Time
Reports
Program Options

4.2 Auto Hiding The Tracking Window

In normal use you keep Complete Time Tracking Standard running continuously rather than
closing and starting it each time that you need to use it. The time tracking window can be
automatically hidden so that it is always immediately available for use without obscuring other
applications.

Hiding the Tracking Window
To automatically hide the time tracking window simply move it to any edge of the screen, top,
bottom, left or right depending on your preference. The window will "snap" to the edge of the
screen. When the mouse is moved away from the time tracking window for a few seconds the
window will automatically hide off-screen. You can control whether the window slides or jumps off
screen in the display options.

Showing the Tracking Window
To show the window again simply move the mouse over the area where the window is hidden. A
small portion of the time tracking window remains at the edge of your screen to remind you where

it is located. Alternatively you can click the Complete Time Tracking icon  in the system tray
area of the Windows taskbar or right-click on the icon and select Show Complete Time Tracking
from the popup menu. You can control whether the window slides or jumps on screen in the 
display options.

The short video tutorials and interactive quick start tutorial show you how to hide and show the
time tracking window.

Note: In some circumstances you might not be able to visually locate the time tracking window.
Some applications might force themselves on top of all other windows and obscure the time
tracking window and some display settings changes might also hide the window. If for some
reason you cannot find the window and the icon is displayed in the system tray area of the
Windows taskbar you can right-click on the icon and select Center on Screen from the popup
menu to center the time tracking window on your screen. You can then drag it back to your
preferred edge of the screen for auto-hiding.

See also:
Display Options
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4.3 Configuring Categories

Complete Time Tracking Standard allows you to track your time to user-defined categories.
Categories are optionally grouped into categories and sub categories. An example grouping would
be customer categories containing project categories and the project categories containing task
categories. You might also create a single top-level category to record personal time.

Before you can effectively use Complete Time Tracking Standard you will need to add some
categories to record your time to. 

To configure categories select Configure Categories from the Tools menu or select the  button
on the toolbar. The category configuration window looks like this: 

When first run Complete Time Tracking Standard contains the following example categories:

Example Customer
Example Project

Example Task A
Example Task B

You can delete these example categories and create your own.

The organization of your categories is entirely up to you. Unlike most other time tracking tools
you define what the categories mean, and you can create category groups containing sub
categories to any level that you wish.

If for example you only want to record time for different customers and do not need to use projects
and tasks you can simply create one category for each customer at the top level. If you need to
record time to projects for customers, create sub categories in each customer for each project. If
you do not need to record time for different customers at all just create top-level project (or other)
categories.

Tip!
If you are planning to track time billing or income then set the hourly rate of the top-level ALL
category so that newly created categories use this hourly rate by default.

Description of Category Options
Category Tree
The category tree on the left of the category configuration window represents the hierarchy of
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categories and sub categories. Use the +/- next to the categories to expand and collapse the list of
sub categories.

You can optionally show categories that have been previously marked as hidden (the category
configuration visibility area is unchecked) by checking the Show hidden categories check box at
the bottom of the category tree. When shown, hidden categories are displayed in colored text.

Category Codes
You can optionally use codes with your categories in addition to referring to them by name. This is
common in a formal project management environment. For example, you may know a customer
more readily as CUS001 rather than Aardvark Printing Services and can therefore assign CUS001
as the code for the customers category.

The category code is displayed above the category description and is hidden by default. You can
enable category codes from the program options window. When enabled, category codes will
appear in the reports.

Category Description
The category description will be displayed in the category tree and in the popup menu for category
selection on the main time tracking window. The description must be unique within its category
group.

Hourly Rate
The hourly rate is used to track billable amounts or to see income.  The amount earned is
displayed for the current time in the main time tracking window, when editing time and in reports.

The hourly rate of newly created categories defaults to the hourly rate set for the Group category
(the category group), therefore it is good practice to set the hourly rate of the Group category
before creating sub categories.

The hourly rate and amount earned can be hidden if desired from the program options window.

Note: The hourly rate refers to the client charge rate (income).

Percent Complete
You can track completion of categories by setting the percentage complete (0-100 in 1 percent
increments). You would normally set the percent complete as you record time for the category
from the main time tracking window by showing the Time Details section. Alternatively you can edit
it in the category configuration window, such as when creating a new category that is already
partially complete.

When categories are marked as 100 percent complete they will be automatically hidden from
selection, category configuration and editing recorded time (see category visibility). You can
disable the automatic hiding of categories marked as 100 percent complete from the program
options window.

Category Visibility

The four visibility options for categories determine where the categories are displayed and
available for selection. This is useful for example when you have completed a project and no
longer wish for the project and its tasks to be displayed when tracking time. This reduces the size
of the category list displayed and therefore makes it easier to select the remaining projects. The
visibility settings are summarized as follows.

Visibility Description
Selection for Time Recording The category can be selected on the main window

to record time against.
Category Configuration The category appears when configuring

categories.
Edit Recorded Time The category appears when editing recorded time.
Reports The category appears in reports.
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Tip! If you will be recording time against both work and personal categories then you can set the
reports visibility of the personal categories to hidden so that personal time is not displayed in
reports.

You can display hidden categories in the category configuration, edit recorded time, and reports
windows by checking the Show hidden categories check box at the bottom of the category list.

When categories are marked as 100 percent complete they will be automatically hidden from
selection, category configuration and editing recorded time (see category visibility). This can be
disabled from the program options window.

Notes:
You can add some notes about each category to record details such as a contact person,
expected completion date, summary of the work involved and so on.

See also:
Program Options
Adding Categories
Modifying Categories
Deleting Categories
Moving Categories

4.3.1 Adding Categories

New categories can be added as either sibling categories (categories at the same level in the
hierarchy) or sub categories of the currently selected category.

Note that there is a special top-level category named ALL under which all categories must be
added.

HOW-TO
Adding Categories
1. Select a category at the level of the sibling and click the Add button or alternatively right-click the

category and select Add Category. The Add Category window will appear and looks like this:

2. Enter the details for the new category, such as description, hourly rate and notes.
3. Select OK to accept your new category details or the Cancel button to cancel adding the

category. The new category will appear in the Category Selection area of the main Category
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Configuration window.
4. You may add several Categories in succession by repeating steps 1 to 3.
5. Select OK in the main Category Configuration window to save all category changes.

HOW-TO
Adding Sub categories
1. Select the Group category and click the Subcategory button or alternatively right-click the Group

category and select Add Subcategory. The Add Category window will appear (refer to step 1 of
adding sibling categories).

2. Enter the details for the new sub category, such as description, hourly rate and notes.
3. Select OK to accept the new sub category details or the Cancel button to cancel adding the sub

category. The new sub category will appear in the Category Selection area of the main Category
Configuration window.

4. You may add several Sub Categories in succession by repeating steps 1 to 3.
5. Select OK in the main Category Configuration window to save all category changes.

See also:
Configuring Categories
Program Options
Modifying Categories
Deleting Categories
Moving Categories

4.3.2 Modifying Categories

Changes can be made to categories and sub categories once you have created them.

HOW-TO
Modify a Category
1. Select the category in the main Category Configuration window and click the Modify button or

alternatively right-click the category and select Modify Category or simply double click on the
category.

The Modify Category window will appear and looks like this:

2. Enter the details you are going to change such as description, hourly rate or notes.
3. Select OK to accept your new changes or the Cancel button to cancel the changes. The

modified details will be saved for the selected category.
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4. You may modify several categories in succession by repeating steps 1 to 3.
5. Select OK in the main Category Configuration window to save all category changes

See also:
Configuring Categories
Program Options
Adding Categories
Deleting Categories
Moving Categories

4.3.3 Deleting Categories

Categories can be deleted once you have created them.

Warning: When you delete a category all sub categories and recorded time for the category and
sub categories will be permanently deleted. If you want to retain your recorded time you can
change the category visibility options to effectively hide it whilst retaining the recorded time.

HOW-TO
Deleting a Category
1. Select the category or sub category and then click the Delete button or right-click the category

and select Delete Category, or select the category and press the Delete key.
2. Continue deleting categories as necessary.
3. When complete select the OK button to save all changes. To cancel all changes click the

Cancel button.

See also:
Configuring Categories
Program Options
Adding Categories
Modifying Categories
Moving Categories

4.3.4 Moving Categories

You can re-arrange categories, such as move a task from one project to another, by dragging the
category in the category tree to the group category you would like to move it to.

See also:
Configuring Categories
Program Options
Adding Categories
Modifying Categories
Deleting Categories

4.4 Program Options

To set the options for Complete Time Tracking Standard click the Options button  on the toolbar
or select Options from the Tools menu.

Categories Options
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Display category codes
If you are using category codes with your customers, projects and tasks, such as in a formal
project management environment, you can choose to display them for category selection. You can
enter the category code in the category configuration window. Category codes will also appear in
the reports if the Display Category Codes option is enabled.

You can also choose the display order of the categories when category codes are enabled.

Group categories can be selected for time recording
Enabling this option allows you to select a Group category to record time to when a specific
subcategory is not applicable.

Hide categories when 100% complete
When a category is marked as complete by setting the percent complete to 100 the visibility
settings for the category are automatically changed to hide it from selection on the main time
tracking window.

You can modify the visibility of categories in the category configuration window.

Recorded Time Options
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Work day start time
Set your normal working start time. This option is used as the default start time for the first
recorded time added in the Edit Recorded Time window.

Display hourly rate and amount earned
You can hide the hourly rate and amount earned from being displayed in windows and reports by
un-checking this option.

Retrieve previous time details for category
When a category is selected on the main time tracking window the notes and percent complete are
automatically retrieved from the last time recorded for the category. The previous notes provide a
hint of what work you were last doing for the category and allow you to update the category percent
complete.

Clear time details notes when time is recorded
When time is recorded on the main time tracking window, such as in automatic time tracking mode
by selecting Stop or switching categories whilst recording or in manual time tracking mode by
selecting Add Time, the time details notes are saved with the new recorded time entry and then
cleared to allow you to enter new notes for the next time entry. Leave this option and the Retrieve
previous time details for category option unchecked to allow time details notes to be edited or
appended to for future recorded time entries.

Set the manual time entry end time to now when time is recorded
When a manually entered time entry is added on the main time tracking window the end time for
the next time entry is set to 'now' (the current time when the Add Time button is clicked). This is
useful when adding time entries throughout the day immediately after completing the item of work.
If you will be predominantly adding all time entries manually at the end of the day then it is more
convenient to disable this option so that you do not need to clear the 'now' text when entering the
end times.

Display duration rounding
This option enables a special duration rounding column in the Edit Recorded Time window. You
can manually override the automatically calculated duration.

Stop recording when the computer is idle
When the computer has not been used for some time you can choose for automatic time recording
to stop recording. On Windows 2000, XP, 2003 and Vista computers you can enter a configurable
number of idle time minutes after which automatic time recording will stop. On Windows 98, ME
and NT4 computers the automatic time recording will stop when the configured Windows



27 Complete Time Tracking Standard v2.54

© 2008 Backslash. All Rights Reserved.

screensaver activates and therefore the duration is controlled by the screen saver wait time.

Resume recording when the computer becomes active
If the stop recording when the computer is idle option is enabled and automatic time recording was
stopped due to inactivity then the recording will start again when the computer becomes active
(when you start using it again).

Inactivity timeout
The number of minutes of inactivity after which time currently recording will be stopped. This is
only available on Windows 2000, XP, 2003 and Vista.

Time Duration Format
You can choose one of three formats to display recorded time durations in:

N.NN hours. For example, 1.25
HH:MM. For example 01:15
HH:MM:SS. For example 01:15:22

Display Options

Main Window Auto-hide
This controls how the main time tracking window shows and hides at the edge of the screen.
There are two options:

Smooth slide: Smoothly move in and out from the edge of the screen.
Jump: Fully appear and disappear without movement.

Enable skinning
Skinning is a feature which allows you to control the theme, or look and feel, of the windows and
controls in Complete Time Tracking. Thirteen pre-defined skins (themes) are provided. Note: To
disable skinning you will need to unselect the Enable skinning option and then close and restart
Complete Time Tracking.

Examples of the main time tracking window without skinning enabled and with three different skins
are shown below.
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Skinning Disabled Vista Default Skin

Highlight Skin Tattoo Skin

Note: Skinning is not currently enabled when running on Windows Vista. It may be supported in a
future release.

Display tooltip hints
Tooltip hints display a short description of an items function when you pause the mouse over it.
This option allows you to turn these hints on or off.

Ignore time gaps
Time gaps, time that has not been recorded, between time entries can be displayed on the Edit
Recorded Time window. This option allows you to adjust the granularity of what is considered to be
a time gap and is used to ignore gaps of small duration.

Ignore time overlaps
Time overlaps, two time entries that overlap, can be displayed on the Edit Recorded Time window.
This option allows you to adjust the granularity of what is considered to be a time overlap and is
used to ignore overlaps of small duration.

General Options
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First day of week
Set the first day of the week. This is usually Sunday or Monday and controls which dates are
selected in the Reports window for the "this week" and "previous week" date range selections.

Report title
The text entered for the report title will appear as the title in all preview and printed reports. A
typical use for this is to display your company name.

Display selected report type in reports
If this option is checked the report type selected on the reports window will be displayed in the title
area of the preview and printed reports.

Display selected category in reports
If this option is checked the category selected on the reports window will be displayed in the title
area of the preview and printed reports.

Display selected date range in reports
If this option is checked the start and end dates selected on the reports window will be displayed in
the title area of the preview and printed reports.

Display user name in reports
If this option is checked the user name text will be displayed in the title area of the preview and
printed reports.

Start when Windows starts
Complete Time Tracking Standard will automatically run when you start Windows, allowing you to
immediately begin using it.

See also:
Configuring Categories
Editing Recorded Time
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5 Tracking Time

5.1 Tracking Your Time

Introduction to Time Tracking

Time tracking is the process of recording time to categories. For information on how to define your
own categories see Configuring Categories.

Complete Time Tracking Standard has two time tracking modes, automatic and manual. You can
easily toggle between the two time tracking modes by selecting the appropriate mode from the Edit

menu or by clicking the  button on the toolbar to change to automatic mode or the  button to
change to manual mode.

Note: You must first stop time recording to switch from automatic to manual time tracking mode.

For an overview of the three main time tracking methods see the First Steps section.

Automatic Time Tracking
Automatic time tracking uses a start/stop "stopwatch" system to record your time. When you
commence work on a particular category you start the timer and when you finish work you stop the
timer.

Continuous recording means that instead of stopping and starting the timer for each category you
can leave the timer running and simply select a different category. Time will automatically stop
recording on the original category and start recording on the new category.

For detailed information see Automatic Time Tracking.

Manual Time Tracking
With manual time tracking you enter the start time and the end time or duration.

For detailed information see Manual Time Tracking.

Selecting a Category
To track your time using either the automatic or manual time tracking mode you must first select
the appropriate category to record the time to. The green category links to the left of the main
window are used to select the category. Example category links are shown in the following figure:

This list of category links shows the category tree "branch" for the selected category, showing up
to three category levels. The selected category is shown last, with its Group categories above it. In
the previous example the selected category is Web Server, a task for a Systems project for
customer Energex Inc.

When a category link is clicked a popup menu appears allowing you to select the appropriate
category. An example popup menu is shown in the following figure:
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The categories that appear in the popup menu depend on which category link that you click:
First category link: All categories from the top level.
Second category link: All categories from the same level as the category clicked.
Third category link: All categories from the same level as the category clicked.

For example in the previous category links screen shot clicking the Systems category link will
display the categories General, Management, Sales and Systems and allow you to select them or
their sub categories.

Selecting a Group Category
Sometimes you need to record time not applicable to a specific category. There are two
approaches to this:

1. Track the time to special "General"/"Other"/"Misc" categories which you create.
2. Track time to the Group category.

For example, you may be working on the Energex Inc, Systems project and need to record some
general time spent on the project. You could create a General subcategory and record time to it or
alternatively record time to the Systems project group category.

By default you cannot select a Group category to record your time to. You can enable or disable
Group category selection from the program options dialog. When enabled the Group category is
displayed at the top of the subcategory list. This is demonstrated in the following screen shot to
select the example Systems Group category:

Time Details: Notes and % Complete
You can optionally enter notes for the recorded time and set a percent complete status for the
selected category. The notes can be viewed when editing previously recorded time or displayed in
the Full Details report.

The time details are displayed at the bottom of the main time tracking window. To show or hide the
time details click the Time Details title bar or the down or up arrow to the right of the heading.

The notes and percent complete are saved when the time recording is stopped or a new category
is selected in automatic time tracking mode, or when adding time in manual mode.
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See also:
Automatic Time Tracking
Manual Time Tracking

5.1.1 Automatic Time Tracking

Complete Time Tracking Standard has two time tracking modes, Automatic and Manual.

Automatic time tracking uses a start/stop "stopwatch" system to record your time. When you
commence work on a particular category you start the timer and when you finish work on that
category you either stop the timer or select a different category to automatically stop recording time
for the original category and start recording time for the new category.

When in automatic time tracking mode Complete Time Tracking Standard looks like this:

HOW-TO
Tracking Time Automatically
1. Ensure that you are in automatic time tracking mode. If you are in manual time tracking mode

then the  button will be displayed on the toolbar. Click it to change to automatic time tracking
mode.

2. Select the category to record your time against.
3. Click the Start button when you commence work on the category.
4. Optionally enter any time details as you work.
5. Click the Stop button when you end work on the category or select a different category to

automatically stop recording on the current category and start recording to the newly selected
category.

Automatic Time Tracking Display
Several items are displayed when in automatic time tracking mode. Information is displayed for the
time currently being recorded or the previous time recorded (if recording is stopped). The
information includes:

· The current time and date.

· The recording start time.

· The recording end time (if recording is stopped).

· The duration in hours:minutes:seconds for the current recorded time, or total duration for the
day.
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· The duration in hours (fractional) for the current recorded time, or total duration for the day.

· The hourly rate for the selected category.

· The amount earned based on the hourly rate and duration.

When time is currently recording you can change the start time by clicking the Started text. The
Adjust Start Time dialog will appear.

You can choose whether to display the current duration and amount earned or the total duration
and amount earned on the main window by clicking the Current text and choosing the appropriate
option from the popup menu.

See also:
Tracking Your Time
Manual Time Tracking

5.1.2 Manual Time Tracking

Complete Time Tracking Standard has two time tracking modes, Automatic and Manual.

With manual time tracking you enter the start time and the end time or duration of the time that you
need to record. Manual time tracking is typically used when you spend most of your time away
from the computer or for quickly bringing the time tracking up to date for events earlier on the
current day such as meetings or work at a remote location.

Note: The manual time tracking mode in the main time tracking window can only be used to enter
time for the current day. The Edit Recorded Time window can be used to add and modify time for
previous days.

When in manual time tracking mode Complete Time Tracking Standard looks like this:
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HOW-TO
Tracking Time Manually
1. Ensure that you are in manual time tracking mode. If you are in automatic time tracking mode

then the  button will be displayed on the toolbar. You can click this button to change to the
manual time tracking mode.

2. Select the category to record your time against.
3. Enter the start time. For example: 14:30, or 2:30 PM.
4. Enter the end time or alternatively the duration. When you change one the other is automatically

adjusted based on the start time.
5. Optionally enter any time details.
6. Click the Add Time button to record the time entered.

Note: See the Time and Duration Formats for valid values that you can enter.

Manual Time Tracking Display
Several items are displayed when in manual time tracking mode. Three items are used to manually
record time for the selected category. The information includes:

· The current time and date.

· The start time. You enter this information.

· The end time. You enter this information or alternatively the duration.

· The duration. You enter this information or alternatively the end time.

· The hourly rate for the selected task.

· The amount earned based on the hourly rate and duration.

Time and Duration Formats
The valid start and end time formats are shown in the table below. You can optionally use the time
separators : and . and the time separator used in your country to separate hours, minutes and
seconds. The pre/post midday suffix such as am/AM and pm/PM used in your country is optional.
Times without the pre/post midday suffix are interpreted in 24-hour format.

Time Entry Interpreted As (24-hour)
10 10:00
17 17:00
5PM 17:00
930 09:30
1730 17:30
173045 17:30:45
9:30 09:30
9:30AM 09:30
9:30PM 21:30
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0:00 00:00
12:00 12:00
12:00AM 00:00
21:30 21:30
21:30:45 21:30:45
now The time when the Add Time button is clicked

The duration can be entered either in time format as above or fractional hours containing your local
decimal symbol, such as the period '.'. For example, , in the U.S. and U.K. the following time
entries are valid:

Duration Entry Interpreted As
1 1 hour
1.5 1 hour 30 minutes
1:00 1 hour
100 1 hour
1:30 1 hour 30 minutes
1:15:30 1 hour 15 minutes 30 seconds

See also:
Tracking Your Time
Automatic Time Tracking

5.2 Editing Recorded Time

You can add recorded time for any day (including previous days) and modify or delete previously
recorded time using the Edit Recorded Time window. To display the edit recorded time window

click the  button on the toolbar or select Edit Recorded Time from the Tools menu.

The Edit Recorded Time window looks like this:

All recorded time for the selected category and date is displayed in the time grid in the lower right
section of the window. The total duration and total amount earned for the selected date are
displayed below the recorded time list.
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From the Edit Recorded Time window you can Add, Modify and Delete recorded time entries and
display and fix Gaps and Overlaps.

Show time from sub-categories
When this option is checked recorded time is displayed for the selected category and all sub
categories. When this option is not checked only recorded time for the selected category is
displayed.

Show Group category names
By default only the name of the actual category that the time was recorded for is shown in the
recorded time details. When this option is checked the full category name hierarchy is displayed.

Duration Rounding
If you have enabled duration rounding from the program options window then a Rounded column
will appear next to the Duration column. You can override the calculated duration by entering a
value into this column. This allows for billing customers in pre-defined time increments. For
example, although a recorded time entry duration might be 01:10 (1 hour 10 minutes) your billing
policy might be to round up to a 15-minute increment. You could therefore enter the rounded
duration as 01:15.

Note: The amount earned column is automatically calculated from the duration and hourly rate and
cannot be directly changed.

See also:
Tracking Your Time
Adding Recorded Time
Modifying Recorded Time
Deleting Recorded Time
Fixing Gaps and Overlaps
Reports Overview

5.2.1 Adding Recorded Time

Time can be added manually in the edit record time window. This is helpful when you are working
remotely.

HOW-TO
Add Recorded Time
1. Click the Add button to add a new recorded time entry, or alternatively right click within the

recorded time entries list and select Add Recorded Time from the popup menu.
2. The Add Time Entry window will appear where you can select the category and time details.

The Add Time Entry window looks like this:



38Tracking Time

© 2008 Backslash. All Rights Reserved.

3. In the Add Time Entry window select the category from the category tree.
4. Enter the start date and time, and the end date and time or end date and duration, and

optionally the hourly rate, category percentage complete and notes.
5. Select OK to accept your new recorded time entry or the Cancel button to cancel adding the

time. The new time will appear in the main edit time window.
6. Select OK in the main Edit Recorded Time window to save all recorded time changes.

Note: The first recorded time added for the day will use a default start time. You can change this
default start time in the program options window.

See also:
Tracking Your Time
Modifying Recorded Time
Deleting Recorded Time

5.2.2 Modifying Recorded Time

Changes can be made to previously recorded time details in the edit recorded time window.

HOW-TO
Modify Recorded Time
There are two ways to edit the recorded time displayed for the selected date:
Method 1 - Modify Time Entry Window
1. Double click on a recorded time row in the list, or select a row and click the Modify button or

right click and select Modify Recorded Time. The Modify Time Entry window will appear and
looks like this:
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2. Select OK to accept your changes or the Cancel button to cancel your changes. If you select OK
the modified time will appear in the main Edit Recorded Time window.

3. Select OK in the main Edit Recorded Time window to save all recorded time changes.

Method 2 - Inline Editing
1. Select an item in the recorded times list that you wish to modify, such as an end time for a

specific time entry, then single click again or press the F2 key to edit the value "in-line".
2. Select OK in the main Edit Recorded Time window to save all recorded time changes.

Note: Method 1 must be used if you want to change the category that the time was recorded
against.

See also:
Tracking Your Time
Adding Recorded Time
Deleting Recorded Time

5.2.3 Deleting Recorded Time

Previously recorded time can be deleted by a user. 

Warning: When you delete a recorded time,the time entry will be permanently deleted.

HOW-TO
Deleting Recorded Time
1. Select the appropriate recorded time entry in the grid and click the Delete button, or right click

and select Delete Recorded Time or select the appropriate recorded time entry and press the
Delete key.

2. Select OK in the main Edit Recorded Time window to save all delete actions.

See also:
Tracking Your Time
Adding Recorded Time
Modifying Recorded Time
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5.2.4 Gaps and Overlaps

It is often important to identify and fix gaps and overlaps in recorded time to ensure that you are
tracking your time accurately.

Gaps

Gaps are empty periods of time between recorded time entries and can occur when automatic
time recording is stopped and then later re-started or if two time entries are manually added and
the start time of the second time entry is later than the end time of the first time entry.

For example, consider a time entry from 09:00 to 10:00 and another time entry from 10:30 to
11:00. A half-hour gap exists between the time entries from 10:00 to 10:30.

Gaps are displayed in the Edit Recorded Time window when all of the following conditions are true:
1. The ALL category is selected in the category list.
2. The Show gaps in recorded time when the ALL category is selected option is checked.
3. Gaps between time entries exist and the gap is at least the configurable number of seconds

specified in the Display Options.

Gaps are highlighted in yellow.

In the previous screen shot the time between 12:55:31 PM and 1:20:10 PM has not been recorded.

You can set which gaps to ignore by specifying the number of seconds in the Display Options. This
is useful to ignore small gaps.

You can fix gaps by manually adding a time entry to fill the gap, manually editing the end time of
the previous time entry or start time of the next time entry, or automatically allocate the time
represented by the gap to a new time entry, the previous time entry, the next time entry, or evenly
allocate to the previous and next time entries.

HOW-TO
Automatically Allocate a Time Gap
Use one of the following methods to allocate the time gap to a time entry:
· Select the gap time entry and click the Allocate button below the listed time entries. Choose the
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appropriate option and select OK.
· Right-click the gap and select the appropriate allocate option from the popup menu.

The allocate time gap dialog is shown below.

Overlaps

Overlaps are periods of time that fall within more than one recorded time entry and can occur
when incorrect start or end times are specified when manually adding or modifying time entries.

There are two main scenarios of overlapping time entries, partial overlaps and full overlaps. A
partial overlap is where only part of two time entries overlap, for example time entries 09:00 to
10:00 and 09:30 to 10:30. A half-hour overlap exists at the end of the first time entry and start of
the second time entry. A full overlap is where one time entry entirely overlaps another time entry,
for example time entries 09:00 to 11:00 and 09:30 to 10:30. The first time entry totally encloses the
second time entry.

Overlaps are displayed in the Edit Recorded Time window when all of the following conditions are
true:
1. The ALL category is selected in the category list.
2. The Show overlaps in recorded time when the ALL category is selected option is checked.
3. Overlaps of time entries exist and the overlap is at least the configurable number of seconds

specified in the Display Options.

Overlaps are highlighted in orange.
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In the previous screen shot the time from 9:40:00 AM to 9:45:00 AM has been recorded in two time
entries.

You can set which overlaps to ignore by specifying the number of seconds in the Display Options.
This is useful to ignore small overlaps.

You can fix overlaps by manually editing the start or end time of time entries so that they no longer
overlap, or automatically trim the overlapping start or end time to remove the overlap.

Note: You can only automatically trim the start or end time of time entries that are not fully
overlapped by another time entry.

HOW-TO
Automatically Trim an Overlap
Use one of the following methods to trim a time entry to remove an overlap:
· Select the time that overlaps (the specific start time or end time highlighted as an overlap) and

click the Trim Overlap button below the listed time entries.
· Right-click the gap and select the appropriate allocate option from the popup menu.

See also:
Editing Recorded Time
Display Options
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6 Reports

6.1 Overview

Complete Time Tracking Standard includes a comprehensive reporting system which allows you to
view, print, copy to the clipboard, and export to file recorded time and optionally billing amounts.

To display the reporting window click the Reporting button  on the toolbar or select Reports from
the Tools menu.

The report window looks like this: 

Report Types
Several report types are available:

Report Type Description

Weekly Timesheet Total duration for each category over a 7-day period
showing category and daily totals.

Summary by Date A total for each date.

Summary by Date and Category A summary showing totals for each category on each date.

Details by Date Individual details for each time entry showing the category
and sub-totals by date.

Summary by Category A total for each category.

Summary by Category and Date A summary showing totals for each date for each category.

Details by Category Individual details for each time entry and sub-totals by
category.

Full Details Full recorded time details for each time entry, ordered by
start date and time with no sub-totals. Useful for exporting
detailed information to file.
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Report Criteria Selection
Date Range

The date range selection specifies which recorded time to include in the report. Several pre-set
date periods are available or you can enter the dates manually or simply select the dates from the
start and end date calendars. 

Pre-set Date Periods
Any pre-set date period with the term Last refers to a period of time up to the current date, for
example Last 7 days.
Any pre-set date period with the term This refers to that current period of time, for example This
Week.
Any pre-set date period with the term Previous refers to a period of time prior to the current period,
for example Previous Week.

For example, if today's date is 15th June then:
· Last 1 Month refers to the period 15th May to 15th June.

· This Month refers to the period 1st June to 30th June.

· Previous Month refers to the period 1st May to 31st May.

Category Selection
Select the category from the category tree to the left of the window. The report will only include
recorded time from the selected category and all sub categories. This allows you to generate a
report for a particular customer or project for example. To include recorded time for all categories
in the report select the top-level ALL category.

Report Category Levels
This controls which sub-categories, if any, to include on the report. Sub-totals by category will be
shown in most report types. For example, if you are only interested in a summary by customer and
you have organized your categories such that customer is the top-level category with project and
task sub-categories, then you can select the ALL category for the report and set Report Category
Levels to 1. If you want sub-totals for each project then set Report Category Levels to 2.

Report Formats
The report output can be generated in several formats:
Report - preview and optionally print
Data - view report data, copy to clipboard and export to file
Export - export the report data

Note: Due to rounding of the individual durations and amounts displayed in the reports, the totals
displayed may differ slightly from the sum of the rounded values.

See also:
Report Preview and Print
Data View
Export Reports

6.2 Report Preview and Print

The Report button generates a preview of a formatted report suitable for printing. In preview mode
you can select and configure the printer and print the report.

Note: A printer must be installed on your computer and a default printer selected in order to use
the Preview and Print functions (a printer driver is used to render the report for previewing). If you
do not have a printer installed or a default printer selected an error message will inform you. To
solve this we recommend that you install the free open source PDFCreator virtual printer which will
allow you to Preview and Print reports in Complete Time Tracking and to print any document from
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any Windows application to a PDF file. You can download PDFCreator from the following web
page.

http://www.pdfforge.org/products/pdfcreator

An example printed report is shown in the following screen shot: 

HOW-TO
Preview a Report
1. Select the report type.
2. Select a date range (this can be done by selecting one of the pre-set dates in the Dates area or

by entering a date range in the Start Date and End Date area).
3. Select the category to include in the report or ALL to report on all categories.
4. Click the Report button.

Preview Window
The three buttons on the left side of the toolbar in the preview window control the preview zoom
setting. There are four navigation buttons allowing you to go to the first page, previous page, next
page or last page in the report. Alternatively you can use the Home, Page Up, Page Down and End
keys.

Printing The Report
You can select the printer to print the report to and change the printer properties by clicking the
Printer Setup button on the toolbar. To print the report to the selected printer click the Print button
on the toolbar.

Report Customization
The program options allow you can choose whether the selected category and date range appear
in the title area of the report.

See also:

http://www.pdfforge.org/products/pdfcreator
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Reports Overview
Data View
Export Reports
Program Options

6.3 Data View

The Data button allows you to quickly see the report data in a table format. This allows you to
preview the data before exporting it to file and to copy the data, or a selected portion of it, to the
clipboard for pasting into another application such as Microsoft Excel.

An example report data view is shown in the following screen shot: 

HOW-TO
View the Data for a Report
1. Select the report type.
2. Select a date range.
3. Select the category to include.
4. Click the Data button.

See also:
Reports Overview
Preview and Print
Export Reports

6.4 Export Reports

The report Export option saves the report data in table format, as shown in the report Data View, to
file. Several file formats are supported.

An example exported report in HTML format viewed in Internet Explorer is shown in the following
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screen shot:

HOW-TO
Export the Report Data to a File
1. Select the report type.
2. Select a date range.
3. Select the category to include.
4. Click the Export button.
5. Select the file type and filename and click Save.

Export File Formats
HTML - The report is saved in a table format in a single-file web page. Suitable for emailing or
publishing on an Intranet.
Text - Tab delimited columns.
Comma Separated - Comma separated columns suitable for loading into a spreadsheet,
database, or other application that supports CSV import.
Microsoft Word - A table-based report in a Microsoft Word document, suitable for re-formatting to
produce a customized report with your company logo for example. Requires Microsoft Word to be
installed on your computer.
Microsoft Excel - A table-based report in a Microsoft Excel document, suitable for adding custom
calculations. Requires Microsoft Excel to be installed on your computer.
XML - Portable data format which can be loaded into many applications.

See also:
Reports Overview
Report Preview and Print
Data View
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7 System

7.1 Backup

You can backup the Complete Time Tracking database as a preventative measure to reduce data
loss or to perform maintenance of your computer such as upgrading or re-installing the operating
system or changing computers. We recommend that you regularly backup your database.

HOW-TO
Backup Your Database
1. Select Backup from the File menu.
2. Browse to the location where you want to save the backup file.
3. Enter a filename and click the Save button.

We recommend that you keep the default .TBK filename extension as this will help when you need
to locate a backup file to restore.

The database is saved in a compressed format. This file can be used to restore the database at a
later time.

See also:
Restore

7.2 Restore

You can restore your Complete Time Tracking database from a previous backup in a data
recovery situation or after maintenance of your computer.

HOW-TO
Restore a Previous Backup
1. Select Restore from the Tools menu.
2. Browse to the location of the previously saved backup file.
3. Select the backup file and click the Open button.

By default backup files are created with a .TBK filename extension.

See also:
Backup
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8 Purchasing and Support

8.1 Purchasing

Purchasing has the following benefits:

· Use Complete Time Tracking Standard beyond the 30-day evaluation period.

· Free technical support.

· Free upgrades to all minor versions.

You must purchase one license for each user (each actual person) that will use Complete Time
Tracking Standard.

HOW-TO 
Purchase Complete Time Tracking Standard
1. Select Purchase Online from the Purchase menu in Complete Time Tracking.
2. Follow the purchasing instructions to complete your order. The quantity entered is the number of

users that you wish to licence (the program enforces the user licence limit).

Unconditional 30-Day Money Back Guarantee

In addition to the 30-day trial period there is also a 30-day unconditional money-back guarantee
from the date that you purchase Complete Time Tracking Standard. If for any reason you would
like a refund simply contact us.

License/Cost Details

For the current price of Complete Time Tracking Standard please visit the web site. Multiple
license discounts are available.

See also:
Entering Registration Key

8.2 Entering Registration Key

When Complete Time Tracking Standard is purchased you will be sent an email containing your
unique registration key. This registration key must be entered into Complete Time Tracking
Standard to remove the 30-day trial restriction. A licence must be purchased for each user (each
person that uses the software). If a multi-user licence is purchased then the registration key will be
valid for the number of users licensed. Licence tracking is enforced by Complete Time Tracking
Standard.

HOW-TO
Enter your registration key
Once you have received your registration key perform the following steps:
1. Start Complete Time Tracking Standard.
2. If you are presented with the evaluation window click on the Enter Key button.
3. If you are not presented with the evaluation window or Complete Time Tracking is already

running select Enter Registration Key from the Purchase menu.
4. Enter your registration details exactly as provided. We recommend copying and pasting the

name and key from your registration email instead of manually typing it to avoid any errors.
5. Click the OK button. You will need to restart Complete Time Tracking for the registration to take

effect.

http://www.complete-time-tracking.com/purchase/
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See also:
Purchasing

8.3 Contact Us

Support 

Please follow these steps for support:

· Ensure that you are running the latest version of Complete Time Tracking Standard. The version
that you are using is displayed in the about window by selecting Help, About from the Complete
Time Tracking menu. Check the Complete Time Tracking downloads web page for the latest
version.

Contacting Support
Support requests will be dealt with high priority. In all correspondence please include your full
name.

Email
1. Select Email Support from the Help menu in Complete Time Tracking Standard (preferred as

this will include some details about Complete Time Tracking and your version of Windows in the
email), or

2. Send an email to support@complete-time-tracking.com

Fax
+1-800-699-0353

Postal Mail
Backslash
PO BOX 2739
Rowville   3178
AUSTRALIA

Program Errors
Please provide the following details with your support query:

Error Report
If an Error Report window is displayed please select the Send Report button to send the error
report in an email to Complete Time Tracking technical support. Please type a description of the
problem and how it occurred in the email.

OR

Send an email to support@complete-time-tracking.com containing the following:
· The symptoms (including a screen shot if possible - that always helps).

· What function you were performing at the time that the error occurred.

· The program version number and database version number displayed on the About window
(select Help, About from the menu).

· Which version of Windows that you are using and if you have the latest Windows updates
installed.

Feedback (Bugs, Suggestions, Comments)
Please select Help, Feedback to send us general feedback and bug reports.

You will be taken to an online form on our web site to select the appropriate feedback option and
enter your comments. This feedback form automatically logs your Windows version and Complete
Time Tracking Standard program version to assist us with your enquiry.

http://www.complete-time-tracking.com/download/
mailto:support@complete-time-tracking.com
mailto:support@complete-time-tracking.com
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